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Epson Stylus CX4100 Series/CX4700 Series 
User’s Guide

This User’s Guide contains instructions on printing and scanning with Windows® or 
Macintosh,® copying photos to and from a memory card (Epson Stylus CX4700 
Series only) or camera, maintaining your Stylus CX all-in-one, solving basic problems, 
and specifications. To set up your Stylus CX and install your software, see the Start 
Here sheet.

Please follow these guidelines throughout:

Warning: Warnings must be followed carefully to avoid bodily injury.

Caution: Cautions must be observed to avoid damage to your equipment.

Note: Notes contain important information about your Stylus CX.

Tip: Tips contain additional hints for better copying, printing, and scanning.

Note: The illustrations in this guide show the Epson Stylus CX4700 Series 
all-in-one and its software, but the instructions are the same for the Epson Stylus 
CX4100 Series all-in-one except where noted.
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About Your Stylus CX

Your Stylus CX all-in-one is great for all your everyday projects and photos. It 
provides you with these advanced features:

■ Epson’s revolutionary DURABrite® Ultra pigment inks. These quick-drying inks 
are resistant to water, fading, and smudging on plain and photo paper so your 
prints stand the test of time.

Note: The light resistance of prints is rated up to 100 years on specialty papers, 
and 70 years on plain paper. The light resistance rating is based on accelerated 
testing of prints on Epson® special media, displayed indoors, under glass. Actual 
print stability will vary according to media, printed image, display conditions, light 
intensity, humidity, and other atmospheric conditions. Epson does not guarantee 
the longevity of prints. For maximum print life, display all prints under glass or 
lamination or properly store them.

■ True BorderFree® frame-ready prints on select 4 × 6 (102 × 152 mm), 5 × 7 
(127 × 178), 8 × 10 (203 × 254), and letter-size (216 ×279) papers. 

■ Built-in Epson Easy Photo Fix™ technology to quickly restore faded color photos 
while you scan so they look as good as new.

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG files so your printer and application can use them to 
create accurate print settings. Most digital cameras store Exif Print information such 
as shutter speed, metering, flash, and exposure settings, resolution, and lens use in the 
JPEG image file. Your printer—along with ArcSoft PhotoImpression—uses the 
information to ensure the most accurate image reproduction.
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About Your Software

The CD-ROM that came with your Stylus CX all-in-one includes all the software you 
need for printing and scanning. See your Start Here sheet for installation instructions.

■ Your printer driver lets you control how your documents look. You can’t print 
from your computer without it.

■ Your scanner software lets you scan from your computer and control how your 
scans look. You can’t scan without it.

Tip: It’s a good idea to check Epson’s support web site periodically for free 
updates to your Stylus CX printing and scanning software. Visit 
http://www.latin.epson.com.

■ ArcSoft PhotoImpression™ lets you edit, retouch, or enhance images and print 
them with templates, frames, and borders. Supports Exif Print. See the 
PhotoImpression Help utility for instructions on using the program.

■ ABBYY FineReader® Sprint lets you scan a document and convert the text into 
data that you can edit with a word processing program.

■ Epson PhotoCenterSM is Epson’s free photo-sharing web site where you can store, 
organize, and share your photos; print high-resolution photos straight from the 
web; and create free online postcards with your photos. Your printer software 
installer lets you add a link to the Epson PhotoCenter on your desktop.

■ Epson Print LabSM is Epson’s free photo project web site where you can combine 
your favorite photos, Epson papers, and your printer to create unforgettable 
personalized craft projects. Your printer software installer lets you add a link to 
the Epson Print Lab on your desktop.
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■ Epson Web-to-Page™ automatically adjusts web pages to fit your printed page. 
No more cut-off edges! All you have to do is select Print on the Web-To-Page 
toolbar in Internet Explorer (requires Windows 98, Me, 2000, or XP with 
Internet Explorer 5.5 or later).
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Loading Paper

■ Single Sheets

■ Envelopes

■ Special Papers

Single Sheets

1. Open the paper support and output tray, then slide out the extensions.

2. Flip the feeder guard forward. 



10

3. Slide the left edge guide to the left.

4. Insert the paper, printable side up, against the right edge guide. Always load it 
short edge first, even for landscape printing. Make sure the paper lies beneath the 
tabs and the arrow mark on the left edge guide.

8 × 10-inch (203 × 254 mm) or 
Letter-size (216 × 297 mm) paper

4 x 6-inch (102 × 152 mm) or 
5 x 7-inch (127 × 178mm) paper
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You can load up to 100 sheets of plain paper and up to 20 sheets of photo paper. 
(See Special Papers for capacity guidelines on other paper types.)

Note: The type of paper you choose affects the way your printout looks, so be 
sure to select the correct paper for your job. If you are just making a copy or 
printing a rough draft of an image, plain paper is fine. However, for the best 
results, you’ll want to use one of Epson’s special ink jet papers designed for your 
printer. For example, your photos will look great printed on Premium Glossy 
Photo Paper. See Special Papers for more information.

5. Slide the left edge guide against the left edge of the paper (but not too tightly).

6. Flip the feeder guard back.
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7. Make sure the paper thickness lever is set down to the L position.

Follow these guidelines when loading paper:

■ Don’t load paper above the arrow on the left edge guide. Make sure the paper is 
under the tabs on the left and right edge guides.

■ Load the printable side face-up. It’s often brighter or whiter than the other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper into the printer top edge first.

■ If you experience paper feeding problems, try loading fewer sheets.

■ If you’re using special paper, check the package for special loading instructions.

Envelopes

1. Open the paper support and output tray, then slide out the extensions.
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2. Flip the feeder guard forward. 

3. Slide the left edge guide to the left.

4. Load up to 10 envelopes at a time, flap edge left, printable side up, against the 
right edge guide.

Note: For best results, press each envelope flat before loading, or load one 
envelope at a time.

5. Slide the left edge guide against the envelopes (but not too tightly).

Load the flap 
edge left, 
printable side up
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6. Flip the feeder guard back.

7. Set the paper thickness lever to the H position.

Select the following settings when printing on envelopes:

■ Envelope as the paper Type or Media Type setting

■ The correct envelope size as the Size or Paper Size setting

■ Landscape as the Orientation setting

For instructions on selecting these settings, see:

■ Printing in Windows

■ Printing with Macintosh OS X
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Special Papers

Epson offers the following special papers for the Stylus CX all-in-one:

* The availability of paper types and sizes varies by location.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office as described in 
Where To Get Help.

Paper name* Size Part number

Epson Ultra Premium Glossy 
Photo Paper

Borderless 4 × 6 in. (102 × 152 mm) S041934

Letter (8.5 × 11 in. [216 × 279 mm]) S041935

Epson Premium Bright White 
Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041586

Epson Premium Glossy 
Photo Paper

Borderless 4 × 6 in. (102 × 152 mm) S041808 
S041727

Borderless 5 × 7 in. (127 × 179 mm) S041464

Borderless 8 × 10 in. (203 × 254 mm) S041465

Letter (8.5 × 11 in. [216 × 279 mm]) S041286

Epson Premium Semigloss 
Photo Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041331

Epson Glossy Photo Paper 4 × 6 in. (102 × 152 mm) S041809

Letter (8.5 × 11 in. [216 × 279 mm]) S041141 
S041649 
S041271

Epson Matte Paper 
Heavyweight

Letter (8.5 × 11 in.) S041257

Borderless 8 × 10 in. (203 × 254 mm) S041467

Epson Double-Sided Matte 
Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041568

Epson Photo Quality Ink Jet 
Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041062

Letter (8.5 × 11 in. [216 × 279 mm]) S041067
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When loading Epson ink jet papers, follow the capacity guidelines below. See 
Selecting the Correct Paper Type for the paper type settings you should select for 
these papers in the printer software.

Printing in Windows

Before you start, make sure the Stylus CX all-in-one is set up, its software is installed, 
and it is connected to your computer as described on the Start Here sheet.

Whenever you print, make sure you do the following:

■ Use the right paper.
For the best-looking photos, most vivid colors, and greatest detail, always use 
genuine Epson papers and Epson inks.

■ Choose the right printer settings.
The Stylus CX automatically adjusts itself for each type of paper. That’s why 
printer settings are important. They tell the Stylus CX what kind of paper you’re 
using and what type of print you want. Make sure you check your printer settings 
every time you print.

See these sections for instructions on selecting printer settings:

■ Printing from an Application

■ Selecting the Default Settings for All Windows Programs

■ Customizing Windows Print Settings

Paper type Loading capacity

Premium Bright White Paper 80 sheets

Ultra Premium Glossy Photo Paper

Premium Glossy Photo Paper

Premium Semigloss Photo Paper

Glossy Photo Paper

Matte Paper Heavyweight

Double-Sided Matte Paper

20 sheets

Photo Quality Ink Jet Paper 100 sheets
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Printing from an Application

After you create a document in a software program, follow these steps to print it using 
the basic printer settings:

1. Open the File menu and select Print. You see a window like this one:

2. Make sure EPSON Stylus CX4100 Series or EPSON Stylus CX4700 Series is 
selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Open your printer 
software

Select EPSON Stylus CX4100 Series 
or EPSON Stylus CX4700 Series
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You see the basic print settings window:

4. Select from these Quality Option types:

■ Draft: For rough drafts with reduced print quality

■ Text: For text-only documents with higher text quality

■ Text & Image: For documents with text and images with higher quality

■ Photo: For photos and graphics with good quality and speed

■ Best Photo: For photos or graphics with high print quality

Note: For more information about print settings, click the ? or Help button.

The Quality Option settings on this screen give you the best combination of 
quality and speed for most prints. For the highest quality (Photo RPM®) on 
selected papers, click the Advanced button on the Main tab. Then see 
Customizing Windows Print Settings for instructions.

5. Make sure the paper Type and Size settings match the paper you’ve loaded in the 
printer. 

Select the type of document you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation
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6. Select your document or image orientation.

7. Click OK.

8. At the Print window, click OK or Print to start printing.

During printing, the following window appears to show the progress of your print 
job. You can use the buttons to cancel, pause, or resume printing. You can also see 
how much ink you have left.

Selecting the Default Settings for All Windows 
Programs

When you change the printer settings within a program, they apply only to that 
program. If you want to change the default printer settings for all your programs, 
follow these steps:

1. Right-click the printer icon in the lower right corner of your screen (taskbar).

Note: If you don’t see the icon, see You don’t see the printer icon in the lower 
right corner of your screen (taskbar) in Windows. for instructions on making it 
appear.

2. Select Printer Settings. You see the window in step 3.

3. Select the default settings you want for all your applications, then click OK.

Click to cancel printing

Click to pause or 
resume printing
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You can still change the printer settings in your individual programs, when necessary. 
They will override the Windows default settings until the next time you turn on or 
reset your computer.

Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

Note: When you select Photo RPM for the highest print quality, printing will take 
longer. 

For more information about advanced settings, or instructions on saving them as 
a group so you can reuse them later, click the ? or Help button. If you want to use 
the Advanced screen each time you access your printer settings, click Show this 
screen first.

Select a color 
management 
method

(To choose 
No Color 
Adjustment, 
click ICM 
first)

Select Paper & Quality 
Options as necessary

Click here to select 
Photo RPM for the 
best print quality on 
certain paper types

Select Print Options 
as necessary



21

4. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print window, and print.

■ Click the Basic button to return to the basic settings.

■ Continue with step 5 to change the layout options.

5. Click the Page Layout tab and select the following page layout settings as 
necessary:

Note: For more information on page layout settings, click the ? or Help button.

6. Click OK to save your settings, then click OK or Print.

Printing with Macintosh OS X

If you’re using an OS X-compatible printing application, follow the steps below to 
print.

Select multi-page 
document options 
here and here

Select image resizing 
options here; these 
affect only your 
printed image

Select image 
position options 

Add a watermark to 
printed page
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Before you begin, make sure you added your printer to the Print Center or Printer 
Setup Utility as described on the Start Here sheet.

1. Open the File menu and select Page Setup. You see the Page Setup window:

2. Select Stylus CX4100 or Stylus CX4700 in the Format for pop-up menu.

3. Select your Paper Size. For borderless printing, select a paper size with the Sheet 
Feeder - Borderless option. See Printing Borderless Photos for details.

4. Select  portrait or  landscape as the orientation setting.

5. Click OK.

6. Open the File menu and select Print. You see a window like this one:

7. Select Stylus CX4100 or Stylus CX4700 in the Printer pop-up menu.

8. Select Print Settings from the pop-up menu.

Select Stylus CX4100 or 
Stylus CX4700

Select your Paper Size

Select your document 
or image orientation

Select Print Settings

Select Stylus CX4100 or 
Stylus CX4700



23

9. Select the following Print Settings as necessary:

Note: For more information about printer settings, click the ? button.

10. Depending on your settings, you can choose other options from the pop-up 
menu:

■ Copies & Pages: Select the number of copies you want or a page range.

■ Layout: Select page layout options.

■ Output Options: Save your print job as a PDF file.

■ Scheduler: Schedule your print job to print at a later time.

■ Paper Handling: Select page printing options, such as Reverse print order.

■ Cover Page: Print a cover page before your document or photo.

■ ColorSync or Color Management: Select ColorSync,® or adjust the color 
controls, change the gamma setting, or turn off color adjustments in the 
printer software.

■ Expansion: Reduce or enlarge the image size for borderless printing. See 
Printing Borderless Photos for details.

Select your Media 
Type

Select Color or 
Black Ink

Select higher 
quality or faster 
printing (if available)

Click Print
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■ Summary: View a list of all your selections.

11. To save your selections for future use, select Save As from the Presets pop-up 
menu.

12. Click Print.

13. To monitor the progress of your print job, click the  printer icon when it 
appears in the dock on the bottom of your desktop. 

If you’re using OS X 10.2.x, click the  Print Center icon instead, then 
double-click Stylus CX4100 or Stylus CX4700 in the Printer List window.

You see a screen like this:

If necessary, you can do one of the following while monitoring the progress of 
your print job:

■ Click the print job, then click Delete to delete it

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

14. When you’re finished, close the printer window or Print Center.
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Customizing Mac OS X Print Settings

You can use advanced settings for color matching or printing at a higher resolution.

1. On the print settings window, click Advanced and choose these settings as 
necessary:

Note: When you select Photo RPM for the highest print quality, printing will take 
longer.

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click the ? button.

2. Click Print.

Selecting the Correct Paper Type

Your Stylus CX all-in-one automatically adjusts itself for the type of paper you select 
in your print settings. That’s why the paper Type or Media Type setting is so 
important. It tells your printer what kind of paper you’re using and adjusts the ink 
coverage accordingly.

For color management 
settings, select Color 
Management from the 
pop-up menu

Select Photo RPM for 
the best print quality on 
certain paper types
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The table below lists the settings you should choose for your paper:

Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the 
edges of the page. Although borderless printing is a bit slower, you get beautiful 
snapshots and enlargements, without trimming. 

See Loading Paper for Borderless Photos, then see these sections for instructions on 
printing borderless photos:

■ Windows

■ Macintosh OS X

For this paper . . .

Select this Type or Media Type 

setting . . .

Plain paper

Epson Premium Bright White Paper

Plain Paper / Bright White Paper

Epson Matte Paper Heavyweight

Epson Double-Sided Matte Paper

Epson Photo Quality Ink Jet Paper

Matte Paper - Heavyweight

Epson Ultra Premium Glossy Photo Paper Ultra Premium Glossy Photo Paper

Epson Premium Glossy Photo Paper Premium Glossy Photo Paper

Epson Premium Semigloss Photo Paper Premium Semigloss Photo Paper

Epson Glossy Photo Paper Glossy Photo Paper

Envelopes Envelope
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Loading Paper for Borderless Photos

You can print borderless photos on these papers and sizes:

Load your paper as shown in Loading Paper.

With proper care, photographs from your Stylus CX all-in-one will last for many 
years. The special Epson DURABrite Ultra inks designed for your Stylus CX are 
formulated to achieve improved lightfastness when used with Epson papers for prints 
that are properly displayed or stored. For best results, always use Epson papers.

As with traditional photos, Epson recommends proper care that will minimize color 
changes and lengthen display life: 

■ Frame prints under glass or a protective plastic sleeve to protect them from 
atmospheric contaminants like humidity, smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ For proper storage, keep your prints in a photo album or plastic photo storage box 
in acid-free, archival sleeves commonly available from most camera stores.

Paper name Sizes

Paper Type or Media Type 

setting

Premium Glossy Photo 
Paper

4 × 6 in. (102 × 152 mm)

5 × 7 in. (127 × 179 mm)

Letter (8.5 × 11 in. 
[216 × 279 mm])

Premium Glossy Photo 
Paper

Premium Semigloss 
Photo Paper

(8.5 × 11 in. 
[216 × 279 mm])

Premium Semigloss Photo 
Paper

Ultra Premium Glossy 
Photo Paper

4 × 6 in. (102 × 152 mm)

Letter (8.5 × 11 in. 
[216 × 279 mm])

Ultra Premium Glossy Photo 
Paper

Epson Glossy Photo 
Paper

4 × 6 in. (102 × 152 mm)

Letter (8.5 × 11 in. 
[216 × 279 mm])

Glossy Photo Paper

Epson Matte Paper 
Heavyweight

8 × 10 in. (203 × 254 mm)

Letter (8.5 × 11 in. 
[216 × 279 mm])

Matte Paper - Heavyweight
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■ Always keep unused paper in the original package. 

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office as described in 
Where To Get Help.

Windows

1. Open the File menu and select Print. 

2. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

You see a window like this one:

3. Select Photo or Best Photo as the Quality Option setting.

4. Select one of the following for the paper Type option, to match the paper you’re 
using:

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

Click the Borderless 
checkbox
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■ Ultra Premium Glossy Photo Paper

■ Matte Paper - Heavyweight

■ Glossy Photo Paper

5. Click the Borderless checkbox. Read the message and click OK.

6. Select your paper Size setting. See the list of supported borderless sizes in Printing 
Borderless Photos.

7. Select Portrait or Landscape as the orientation setting.

8. Click the Page Layout tab. You see a window like this one:

9. If necessary, adjust the Expansion slider in the Borderless box to choose Min, 
Max, or the in-between setting. 

Min retains most image area in your print, but there may be a small white edge on 
the borders of the print. Max expands the image to ensure that there are no 
unprinted edges, but the edges of the image may not appear in the print. 

10. Click OK.

11. At the Print window, click OK or Print.

Expansion 
slider
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Macintosh OS X

1. Open the File menu and select Page Setup. You see a window like this one:

2. Select Stylus CX4100 or Stylus CX4700 in the Format for pop-up menu.

3. Select one of the following settings as your Paper Size:

■ 4 × 6 (Sheet Feeder - Borderless)

■ 5 × 7 (Sheet Feeder - Borderless)

■ 8 × 10 (Sheet Feeder - Borderless)

■ US Letter (Sheet Feeder - Borderless)

4. Select  portrait or  landscape as the orientation setting.

5. Click OK.

6. Open the File menu and select Print.

7. Select Stylus CX4100 or Stylus CX4700 in the Printer pop-up menu.
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8. Select Print Settings from the pop-up menu.

9. Select one of the following for the Media Type option, to match the paper you’re 
using:

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Ultra Premium Glossy Photo Paper

■ Matte Paper - Heavyweight

■ Glossy Photo Paper

10. Select Quality (for higher quality) or Speed (for faster printing) using the slider.
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11. Select Expansion from the pop-up menu. You see a window like this one:

12. If necessary, adjust the Expansion slider to choose Min, Max, or the in-between 
setting. 

Min retains the most image area in your print, but there may be a small white 
edge on the borders of the print. Max expands the image to ensure that there are 
no unprinted edges, but the edges of the image may not appear in the print. 

13. Click Print.
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Placing Originals for Scanning

Caution: Do not place heavy objects on the document table glass and do not 
press the glass with too much force.

1. Open the document cover and place your original face-down on the glass, in the 
upper left corner. Move your original about 1 mm (0.04 inch) away from the top 
and left edges so all of it will be scanned.

2. Close the document cover gently so that your original does not move.

Caution: Never open the document cover beyond where it stops and do not 
place heavy objects on top of the Stylus CX all-in-one.

Note: If you are scanning a large or thick document, you can remove the 
document cover. See Placing Large or Thick Documents for instructions.

To scan your document or photo, see Starting EPSON Scan.
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Placing Large or Thick Documents

When you scan a large or thick document, you can remove the document cover. Just 
open it and pull it straight up.

If you need to press the document flat while you copy or scan it, do not press too hard 
and be careful not to move it.

Caution: Do not use excessive force on the document cover, and do not twist it 
diagonally. You may damage the document cover.

When you are done, replace the document cover by inserting the tabs back into the 
slots.
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Starting EPSON Scan

If you want to scan an image and save it directly to a file, you can start EPSON Scan 
as a “standalone” program.

You can also use any TWAIN-compliant scanning program, such as ArcSoft 
PhotoImpression, to scan with EPSON Scan. When you are finished, the scanned 
image opens in your scanning program so you can modify, print, and save it.

EPSON Scan offers three scanning modes. See Overview of the EPSON Scan Modes 
for a description.

Then follow the steps in one of these sections to start EPSON Scan:

■ Starting EPSON Scan as a Standalone Program

■ Starting EPSON Scan With Another Scanning Program

Overview of the EPSON Scan Modes

EPSON Scan lets you control all aspects of scanning and includes three modes:

■ Full Auto Mode lets you scan quickly and easily, without selecting any settings or 
previewing your image. This is the default mode in EPSON Scan.

Full Auto Mode is best when you need to scan documents or photos at 100% size 
and you do not need to preview the images before scanning. You can restore faded 
colors by clicking the Customize button. 

■ Home Mode lets you customize some scanning settings and check their effects 
with a preview image.

Home Mode is best when you want to preview images of photos before scanning 
them. You can size the image as you scan, adjust the scan area, and adjust many 
image settings, including color restoration. 

■ Professional Mode gives you total control of your scanning settings and lets you 
check their effects with a preview image.

Professional Mode is best when you want to preview your image and make 
extensive, detailed corrections to it before scanning. You can sharpen, color 
correct, and enhance your image with a full array of tools, including color 
restoration.
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Starting EPSON Scan as a Standalone Program

1. Do one of the following to start EPSON Scan:

Windows: Double-click the EPSON Scan icon on your desktop.

Or select Start > All Programs or Programs > EPSON Scan > EPSON Scan.

Mac OS® X: Open the Applications folder and click the EPSON Scan icon.

The EPSON Scan standby window appears:

2. If the Mode setting in the upper right corner of the window is set to Full Auto 
Mode, click the Scan button. (For instructions on selecting optional settings, see 
Using Full Auto Mode.)

Note: If you are in Home or Professional Mode, you see the EPSON Scan 
settings window. For instructions on using Home or Professional Mode, see 
Selecting Basic Settings. To change scan modes, see Changing the Scan Mode.
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3. The File Save Settings window appears. For instructions on selecting options, see 
Selecting File Save Settings.

4. When you are finished selecting File Save Settings, click OK. EPSON Scan starts 
scanning in Full Auto Mode.

5. The scanned image is automatically saved in the specified location.

If the Open image folder after scanning checkbox is selected in the File Save 
Settings window, Windows Explorer or the Macintosh Finder automatically 
opens to the folder where the scanned image was saved.

For more information, see Using Full Auto Mode.

Starting EPSON Scan With Another Scanning 
Program

1. Start your scanning program. 

Double-click the program icon from your desktop, if it is available, or do one of 
the following:

Windows: Select Start > All Programs or Programs > program folder > 
program icon.
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Mac OS X: Open the Applications folder, select the program folder, and click 
the program icon.

2. Select your program’s scanning option. (See your scanning program help for 
instructions.)

For example, in ArcSoft PhotoImpression, open the File menu and select Get 
Photo. Then click the Camera/Scanner icon.

Note: In some programs, you must select the Stylus CX as the “source” first. If 
you see a Select Source option, choose it and select your Stylus CX there first.

3. Select your Stylus CX all-in-one.

Note: With Windows XP, do not choose a WIA option for your Stylus CX; it will 
not work correctly.

EPSON Scan starts automatically. For instructions on using it, see Selecting 
EPSON Scan Settings.

Selecting File Save Settings

When you see the File Save Settings window, you need to select the location, name, 
and format of the scanned image file you want to save.

1. In the File Save Settings window, specify the file folder in which you want to save 
your scanned image. Click Browse (Windows) or Choose (Macintosh) and 
select the folder.
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2. Specify a file name prefix with an alphanumeric character string. A 3-digit 
number is automatically added to the file name, but you can change the Start 
Number if you like. If you are scanning multiple images at once, each image will 
receive a different 3-digit number.

Note: With Windows, the following characters cannot be used in the prefix.
\, /, :, ., *, ?, ", <, >, |. On a Macintosh, you cannot use a colon (:) in the prefix.

3. Select a file format as described in the following table. Depending on the format, 
the Options button may be available for making detailed settings.

Format (File 

Extension) Explanation

BITMAP 
(*.BMP) 
(Windows 
only)

A standard image file format for Windows. Most Windows 
programs, including word processing programs, can read and 
prepare images in this format.

JPEG (*.JPG) A compressed file format in which the compression level can 
be selected. The JPEG format lets you highly compress image 
data. However, the higher the compression, the lower the 
image quality. Any lost image quality data cannot be restored 
and the quality deteriorates each time the data is saved. The 
TIFF format is recommended when modification and retouching 
are required.
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4. The checkboxes at the bottom of the window give you these options:

■ Overwrite any files with the same name

Select this option if you want to reuse the selected file name and location and 
overwrite previous files with the same names.

■ Show this dialog box before next scan

Select this option if you want the File Save Settings window to appear 
automatically before you scan. If you deselect it, you must click the arrow to 
the right of the Scan button and select File Save Settings to open the 
window.

■ Open image folder after scanning

Select this option if you want Windows Explorer or the Macintosh Finder to 
automatically open to the folder where your scanned image is saved when 
EPSON Scan finishes scanning.

Multi-TIFF 
(*.TIF)

A TIFF format where multiple pages are saved to the same file. 
(With other formats, each document is saved in a separate file.) 
You can also edit the images before saving them. To open 
Multi-TIFF files, you need a program that supports it.

TIFF (*.TIF) A file format created for exchanging data between many 
programs, such as graphic and DTP software. When scanning 
black & white images, you can specify the compression type.

PDF (*.PDF) A document format that can be read on both Windows and 
Macintosh systems (platform independent). To use PDF 
documents, you need Adobe Reader® or Acrobat.® Multi-page 
documents can be saved as one PDF file. When you save color 
or grayscale images in PDF, you can select a compression level. 
You can also edit the scanned images before saving them. See 
Scanning Directly to a PDF File for details.

PICT (*.PCT) 
(Macintosh 
only)

A standard image file format for Macintosh. Most Macintosh 
programs, including word processing programs, can read and 
prepare images in this format.

PRINT Image 
Matching II 
JPEG (*.JPG) 
or TIFF (*.TIF)

A file format that includes PRINT Image Matching™ II data for 
enhanced quality and a wider color range. PRINT Image 
Matching II compatible printers can then print using this data for 
brilliant, true-to-life results. (PRINT Image Matching data does 
not affect the way the image displays on a screen.) Available in 
JPEG or TIFF format. 
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5. Click OK. EPSON Scan starts scanning.

The scanned image is saved in the file and location you chose.

Selecting EPSON Scan Settings

Follow the instructions in these sections to change the EPSON Scan mode, if 
necessary, and select scanning settings:

■ Changing the Scan Mode

■ Using Full Auto Mode

■ Selecting Basic Settings

■ Selecting the Scan Resolution

■ Previewing and Adjusting the Scan Area

■ Adjusting the Color and Other Image Settings

■ Selecting the Scan Size

■ Finishing the Scan

Changing the Scan Mode

To change the scan mode, click the arrow in the Mode box at the top right of the 
EPSON Scan window. Then select the mode you want to use from the list that 
appears.

Note: The mode you select remains in effect when you start EPSON Scan the 
next time.

For instructions on scanning using these modes, see:
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■ Full Auto Mode: Using Full Auto Mode.

■ Home or Professional Mode: Selecting Basic Settings.

Using Full Auto Mode

When you start EPSON Scan for the first time, it runs in Full Auto Mode and 
displays the EPSON Scan standby window:

Note: If you want to change the scan mode, see Changing the Scan Mode.
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1. If you want to select a custom resolution or restore faded colors in your image, 
click the Customize button. You see the Customize window:

Select your settings and click OK. (For details on selecting settings, click the Help 
button.)

2. Click the Scan button. 

3. The File Save Settings window appears. For instructions on selecting options, see 
Selecting File Save Settings.
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4. When you are finished selecting File Save Settings, click OK. EPSON Scan starts 
scanning in Full Auto Mode. 

EPSON Scan previews your image, detects whether it is a photo or document, 
and selects the scan settings automatically. After a moment, you see a small 
capture of your image in the EPSON Scan window.

Note: If you need to change any settings, click the Pause button. You return to 
the EPSON Scan standby window. If you need to cancel scanning, click the 
Cancel button when it appears.

5. Depending on how you started EPSON Scan, the program saves the file to the 
location you specified or opens the scanned image in your scanning program. See 
Finishing the Scan for details.

Selecting Basic Settings

When you start EPSON Scan in Home or Professional Mode, you see the main 
EPSON Scan window:
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Home Mode



48

Professional Mode

Before you scan your document or photo, you need to select these basic settings:

■ Original settings. These tell EPSON Scan the type of document or photo you are 
scanning.

■ Destination settings. These tell EPSON Scan how you plan to use your scanned 
image so it can select the correct default resolution (scan quality) for you.

Follow these steps to select the basic settings for a document or photo in EPSON 
Scan:

1. Do one of the following to select your document type:

Home mode:

Click the arrow to open the Document Type list and select the type of original 
you are scanning. Then click the Color, Grayscale, or Black & White button to 
select the colors in the original.

Professional mode:
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Click the arrow to open the Document Type list and select Reflective (for 
scanning a document or photo). Then click the arrow in the Auto Exposure Type 
list and select Document or Photo.

2. Do one of the following to select your destination setting(s):

Home mode:

Click the button for the way you plan to use the scanned image in the Destination 
box:

■ Screen/Web for images you will view only on a computer screen or post on 
the web.

■ Printer for images you will be printing or converting to editable text with an 
OCR (Optical Character Recognition) program.

■ Other if you want to select a specific resolution for other purposes.

Professional mode:

Click the arrow to open the Image Type list and select the detailed image type you 
are scanning:

3. EPSON Scan selects a default resolution setting based on the original and 
destination settings you select. See Selecting the Scan Resolution to continue 
scanning. 

Image Type 

setting Type of image you are scanning

24-bit Color Color photo

Color Smoothing Color graphics, such as a chart or graph

16-bit Grayscale Black-and-white photo with many shades of gray

8-bit Grayscale Black-and-white photo with just a few shades of gray

Black & White Document with black text and/or line art
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Selecting the Scan Resolution

In Home Mode, you can change the resolution only if you select Other as the 
Destination setting.

In Professional Mode, you can select the resolution you want at any time.

Before you select the scan resolution, you should consider whether you will enlarge 
the images, and if so, whether you will enlarge them before or after you scan. Follow 
these guidelines:

■ You will not be enlarging the images.

If you will scan the images at 100% size or smaller and will not enlarge them later, 
you can accept the Resolution setting selected by EPSON Scan based on your 
original and destination settings.

■ You will enlarge the images as you scan them (increase the Target Size setting).

If you will enlarge the images in EPSON Scan so you can use them at a larger size, 
you can accept the Resolution setting selected by EPSON Scan based on your 
original and destination settings.

■ You will scan the images at their original size, but then enlarge them later in an 
image-editing program.

If you plan to enlarge your images later in an image-editing program, you need to 
increase the Resolution setting to retain a high image quality after enlargement. 
Increase the resolution by the same amount you will increase the image size. For 
example, if the resolution is 300 dpi (dots per inch), but you will increase the 
image size by 200% in an image-editing program, change the Resolution setting 
to 600 dpi in EPSON Scan.
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Click the arrow next to the Resolution list and select the number of dots per inch at 
which you want to scan. See the table below for some guidelines:

After selecting the Resolution, you can preview your image and make any necessary 
adjustments. See Previewing and Adjusting the Scan Area to continue scanning.

Previewing and Adjusting the Scan Area

Once you have selected your basic settings and resolution in Home or Professional 
Mode, you can preview your image and select or adjust the area of the image(s) you 
want to scan. EPSON Scan displays the preview image(s) in a separate Preview 
window on your screen.

There are two types of preview:

■ Normal preview displays your previewed images in their entirety. You must select 
the scan area and make any image quality adjustments manually. Normal is the 
default preview type in Professional Mode, but you can also select it in Home 
Mode, if available.

■ Thumbnail preview displays your previewed images as thumbnails. EPSON Scan 
automatically locates the edges of your scan area and applies automatic exposure 
settings to the images. Thumbnail is the default preview type in Home Mode, 
but you can also select it in Professional Mode, if available.

Note: Depending on your document type and other settings, Normal preview 
may be automatically selected and you will not be able to change to Thumbnail 
preview. 

What you will do with the 

scanned image Suggested scan resolution

Send via e-mail, upload to web, view 
only on the screen

96 to 150 dpi

Print, convert to editable text (OCR) 300 dpi

Fax 200 dpi

Enlarge after scanning at 100% Increase Resolution setting by same amount 
you will increase image size after scanning
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Follow these steps to preview your image(s) in Home or Professional Mode:

1. Click the Preview button toward the bottom of the EPSON Scan window. If 
you want to check or change the preview type, click the arrow next to the 
Preview button, if it is available.

EPSON Scan prescans your image(s) and displays them in one of the following 
Preview windows:

Normal preview
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Thumbnail preview

2. If you are viewing the Thumbnail preview, you can do the following to adjust the 
image(s):

■ To zoom in on an image, double-click its thumbnail, or click the thumbnail 
and then click the Full Size tab near the top of the Preview window. 
(Available only when you’ve scanned multiple images at one time.)

■ To rotate an image or flip it horizontally (like a mirror image), click its 
thumbnail and then click the rotation icon or mirroring icon.

■ To adjust the scan area to crop your image, you can create and move a 
marquee that marks the edges of your scan. See Adjusting the Scan Area 
(Marquee) for instructions.

■ To adjust the image quality, click the image(s) you want to modify and make 
the adjustments as described in Adjusting the Color and Other Image 
Settings. If you want to apply the adjustments you have made to all your 
images, click the All button.

3. If you are viewing the Normal preview, you can do the following to adjust the 
image(s):
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■ To select your scan area, click the auto locate icon to place a marquee that 
marks the edges of your image area. You can move the marquee to change the 
scan area. See Adjusting the Scan Area (Marquee) for instructions.

Note: If you are going to scan at a different size than your original, you must 
first select your Target Size and automatically create a marquee that is 
proportioned to that size. See Selecting the Scan Size for instructions. You 
can then copy the marquee and place it on each image you will scan at that 
size.

■ To zoom in on an image, click inside the scan area and click the Zoom 
button. EPSON Scan prescans again and displays a larger preview on the 
Zoom tab. (Your other images are still previewed at the original size on the 
Preview tab.)

■ To adjust the image quality, click the image(s) you want to modify and make 
the adjustments as described in Adjusting the Color and Other Image 
Settings. 

4. When you have finished adjusting the scan area, and modifying the color and 
image settings, you can select the size of your scanned image, if you have not 
already selected it. See Selecting the Scan Size for instructions.

Adjusting the Scan Area (Marquee)

A marquee is a moving dotted line that appears on the edges of your preview image to 
indicate the scan area. 

Marquee
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You can move the marquee, adjust its size, and create multiple marquees on one 
image (Normal preview only) to scan different image areas in separate scan files. 
Follow these steps:

1. To draw a marquee, move your cursor over a preview image. The pointer becomes 
a set of cross-hairs. 

2. Position the pointer in the area where you want to place the corner of your 
marquee and click. Hold down the mouse button and drag the cross-hairs over 
the image to the opposite corner of the desired scan area. Then release the mouse 
button. You see the moving dotted line of the marquee.

3. Do one of the following to adjust the marquee:

■ To move the marquee, position your cursor inside the marquee. The pointer 
becomes a hand. Click and drag the marquee to the desired location.
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■ To resize the marquee, position your cursor over the edge or corner of the 
marquee. The pointer becomes a straight or angled double-arrow. Click and 
drag the edge or corner to the desired size.

Note: To restrict movement of the marquee to vertical or horizontal only, hold 
down the Shift key as you move the marquee. To restrict sizing of the 
marquee to the current proportions, hold down the Shift key as you resize 
the marquee.

4. To draw multiple marquees (up to 50; Normal preview only), you can just draw 
them as described in steps 1 through 3, or click the copy marquee icon to 
create additional marquees of the same size. You can move and resize all the 
marquees as described in step 3. To delete a marquee, click inside it and click the 

delete marquee icon.

Adjusting the Color and Other Image Settings

Once you have previewed your images and adjusted the scan area, you can modify the 
image quality, if necessary. EPSON Scan offers a variety of settings for improving 
color, sharpness, contrast, and other aspects affecting image quality.
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Before you make adjustments, be sure to click the image or marquee for the area you 
want to adjust. In Professional Mode, you also need to scroll down to the 
Adjustments area of the main EPSON Scan window:

The table below describes the settings available in Home and/or Professional Mode. 
For details on adjusting these settings, click Help in the EPSON Scan window.

When you are finished making adjustments, you can size your scanned images (see 
Selecting the Scan Size) or go ahead and scan (see Finishing the Scan).

Setting Available mode(s) and description

Color Restoration Home and Professional:
Restores the colors in faded photos automatically.

Brightness Home and Professional:
Adjusts the overall image lightness and darkness.

In Home Mode, click the Brightness button to access the 
Brightness setting.

In Professional Mode, click the Image Adjustment button to 
access the Brightness setting.

Contrast Home and Professional:
Adjusts the difference between the light and dark areas of the 
overall image.

In Home Mode, click the Brightness button to access the 
Contrast setting.

In Professional Mode, click the Image Adjustment button to 
access the Contrast setting.

Saturation Professional only:
Adjusts the density of colors in the overall image.

Click the Image Adjustment button to access the Saturation 
setting.
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Color Balance Professional only:
Adjusts the balance of red, green, and blue colors in the overall 
image.

Click the Image Adjustment button to access the Color 
Balance setting.

Auto Exposure Home: Automatically applied.

Professional: Click the Auto Exposure button. To turn it on 
continuously, click the Configuration button, click the Color tab, 
and select Continuous auto exposure. You can adjust the level 
of exposure adjustment using the slider.

Unsharp Mask 
Filter

Home: Automatically applied.

Professional: Turn on to make the edges of image areas clearer 
for an overall sharper image. The level of sharpness is 
adjustable. Turn off to leave softer edges.

Descreening Filter Home and Professional:
Removes the rippled pattern that can appear in subtly shaded 
image areas, such as in skin tones. Also improves results when 
scanning magazine or newspaper images which include 
screening in their original print processes. The results of the 
Descreening Filter do not appear in the preview image, only in 
your scanned image.

Histogram Professional only:
Provides a graphical interface for adjusting highlight, shadow, 
and gamma levels individually. For advanced users only.

Click the Histogram Adjustment button to use the Histogram 
settings.

Tone Correction Professional only:
Provides a graphical interface for adjusting tone levels 
individually. For advanced users only.

Click the Tone Correction button to use the Tone Correction 
settings.

Threshold Home and Professional:
Adjusts the level at which the black areas in text and line art are 
delineated, improving text recognition in OCR programs. 
(Available only when you select Black & White as the Image 
Type setting.)

In Home Mode, click the Brightness button to access the 
Threshold setting.



59

Note: To view the red, green, and blue levels at particular points in your preview 
image as you make adjustments, click the densitometer icon in the preview 
window and click an image area. See EPSON Scan help for details.

Certain settings may not be available, or may be automatically selected, 
depending on the type of image you are previewing and other settings you have 
selected.

You can customize how certain EPSON Scan settings behave by clicking the 
Configuration button and changing settings in the window that appears. See 
EPSON Scan Help for details.

To undo any image quality adjustments you make to the preview image, click the 
Reset button (if available), turn off the setting, or preview your image again.

Selecting the Scan Size

You can scan your images at their original size, or you can reduce or enlarge their size 
as you scan them. You do this using the Target Size setting in Home or Professional 
Mode.

Home Mode

Professional Mode
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If you are going to scan your image to a particular size, such as 8 × 10 inches, you 
should select the Target Size setting after previewing it, but before adjusting your scan 
area (indicated by the marquee). This sets the scan area to the correct proportions so 
your image will not be cropped unexpectedly. 

For instructions on previewing your image(s), see Previewing and Adjusting the Scan 
Area. Then follow these steps to select the Target Size setting:

1. You can choose a predefined scan size from the Target Size list. Click the arrow in 
the list and select the size you want. A marquee (dotted line) proportioned for that 
size appears on your preview image:

Proportioned 
marquee
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2. If you need to create a scan size that is not in the Target Size list, you can create a 
custom size. Click the arrow in the list and select Customize. You see the Target 
Size window:

Type a name for your custom size, enter the size, click the Save button, then 
click OK. Your new size appears in the Target Size list.

3. In Professional Mode, you can fine-tune the size using additional tools. Click the 
+ (Windows) or (Macintosh) next to Target Size to display these tools:

■ To size your image by a certain percentage, adjust the Scale value.

■ To change the way your image is cropped, turn Trimming on or off. (See 
EPSON Scan Help for details.)

■ To unlock the proportions of your scan size, click the lock icon. Then 
adjust the marquee or enter new width/height measurements.

4. Once you have selected your scan size, you can click and drag the marquee to the 
area in the image you want to scan. For details, see Adjusting the Scan Area 
(Marquee). The marquee proportions are retained as you adjust it.
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If you need to rotate the marquee for a landscape or portrait image, click the 
orientation icon. (Not available if you are scanning at the Original Target 

Size.)

Note: For more information about using the Target Size tools, click Help in 
the EPSON Scan window.

5. Now you are ready to scan your image(s). See Finishing the Scan for instructions.

Finishing the Scan

When you have finished selecting scan settings, you are ready to scan. Click the Scan 
button. After a few moments, your images are scanned.

What happens after you scan depends on how you started your scan:

■ If you started your scan by running EPSON Scan as a standalone program, 
you see the File Save Settings window. This lets you select the name and 
location of your saved scan files. See Selecting File Save Settings for details.

■ If you started your scan from a scanning program such as ArcSoft 
PhotoImpression, your scanned image(s) open in the program window. Click 
Close to close the EPSON Scan window and view your image(s) in the 
program.
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Restoring Color in Photos

Using the Color Restoration feature in EPSON Scan, you can automatically 
transform an old, faded, or badly exposed photo into one with true-to-life color and 
sharpness as you scan.

Follow these steps to restore colors using EPSON Scan:

1. Place your original photo on the scanner. See Placing Originals for Scanning for 
instructions:

2. Start EPSON Scan. See Starting EPSON Scan for instructions:

3. When the EPSON Scan window appears, do one of the following, depending on 
the currently selected scan mode:

■ Home or Professional Mode: go to step 4..

■ Full Auto Mode: click the Customize button, click the Color Restoration 
checkbox, and click OK. Continue with step 9.

Note: For details on using Full Auto Mode, see Using Full Auto Mode.

To change the scan mode, see Changing the Scan Mode. 

4. Select the basic settings for the type of original(s) you are scanning, then select the 
destination setting for the way you will use your image(s). See Selecting Basic 
Settings for instructions:
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5. Click the Preview button to preview your image(s), then select your scan area. 
See Previewing and Adjusting the Scan Area for instructions:

6. Do one of the following to select the Color Restoration option:

■ Home Mode: Click the Color Restoration checkbox.

■ Professional Mode: Scroll down to the Adjustments area and click the Color 
Restoration checkbox.

7. Make any other necessary image adjustments. See Adjusting the Color and Other 
Image Settings for instructions:

8. Size your image as necessary. See Selecting the Scan Size for instructions:

9. Click the Scan button to scan and restore the color in your image(s).

What happens next depends on how you started EPSON Scan. See Finishing the 
Scan for details.

Scanning Directly to a PDF File

You can scan multiple pages of a document on the document table and save them as 
one PDF file on your computer. EPSON Scan displays an editing page so you can 
view the pages as you scan them and reorder, rotate, or delete them as necessary.

1. Place the first page of your original document on the document table. See Placing 
Originals for Scanning for instructions.
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2. Start EPSON Scan. See Starting EPSON Scan for instructions:

3. If the Mode box at the top right of the EPSON Scan window is set to Full Auto 
Mode, click the Scan button.

If the Mode box is set to Home Mode or Professional Mode, see Selecting 
Basic Settings for instructions.

Note: If you want to change the scan mode, see Changing the Scan Mode.
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The File Save Settings window appears:

Select PDF as the file type setting. The current Paper Size, Orientation, Margin, 
and Compression setting are displayed below it.

4. If you need to change any of the current PDF settings, click the Options button. 
You see the EPSON PDF Plug-in Settings window:

Select the settings that match your document and click OK. You return to the File 
Save Settings window.



69

5. When you are finished selecting file settings, click OK. EPSON Scan scans your 
page and displays this window:

6. If you are scanning only one document page, click Done and go to step 7.

If you are scanning multiple pages, click Add page and replace the first page on 
the document table with the second page and click Scan. Repeat this step for 
each page in your document. When you are finished, click Done and go to step 7.

7. You see the Editing Page window displaying thumbnail images of each scanned 
page:

Note: If you cleared the Display the Editing Page dialog box before saving 
the files checkbox on the EPSON PDF Plug-in Settings window, you do not 
see the Editing Page window. Go to step 9.
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If you want to include all the document pages in your PDF file as they currently 
look, go to step 8.

If you want to include only some of the pages, click the odd pages or even 
pages icons, or click the individual pages you want to include.

If you want to rotate or delete pages, click the pages or use the odd pages, 
even pages, or all pages icon to select the pages. Then click the  left or 
right rotate icon to rotate them or the delete icon to delete them.

Note: The delete icon is not available when all document pages are 
selected.

8. When you have finished editing your document pages, click OK. Your document 
is saved in a PDF file in the location you selected and you return to the EPSON 
Scan window.

9. Click Close to exit EPSON Scan.
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Copying Photos To and From a Memory 
Card (Epson Stylus CX4700 Series)

You can copy photo files to and from a memory card inserted in a card slot the Epson 
Stylus CX4700 Series all-in-one when it is connected to your computer. Make sure to 
follow the guidelines in Memory Card Copying Precautions before you copy photo 
files.

Follow the steps in these sections to copy photo files to and from the card and your 
computer:

■ Copying Photo Files to Your Computer

■ Copying Photo Files to Your Memory Card

When you finish copying files to or from a memory card, see Disconnecting or 
Turning Off the Epson Stylus CX4700 Series for additional instructions.

Memory Card Copying Precautions

Keep the following in mind when copying photos to and from your memory card and 
computer:

■ Check for any handling guidelines in the documentation that came with your 
memory card and adapter.

■ Do not eject your memory card or turn off the CX4700 Series while the memory 
card access light is flashing or you may lose data.

■ Make sure that your memory card is not write-protected. Many memory cards 
have a write-protect switch or seal.

■ Do not copy photos to or from a memory card while you’re printing from the 
memory card.

Copying Photo Files to Your Computer

First install your Epson Stylus CX4700 Series software and connect it to your 
computer as described on the Start Here sheet. Then insert your memory card 
following the instructions in the printed Quick Guide. 

1. Do one of the following:
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Windows XP: Click Start and select My Computer.

Windows 98, Me, or 2000: Double-click the My Computer icon on your 
desktop.

Macintosh OS X: Go to step 2.

2. Double-click the removable disk icon, then select the folder in which your photo 
files are saved.

3. Select the photo files you want to copy and drag them to a folder on your 
computer’s hard drive. 

4. When you’re finished, follow the steps in Disconnecting or Turning Off the 
Epson Stylus CX4700 Series before turning off the CX4700 Series.

Copying Photo Files to Your Memory Card

First install your CX4700 Series software and connect it to your computer as 
described on the Start Here sheet. 

Before inserting your memory card, make sure the write-protect switch or seal is set to 
allow writing to the memory card. Then insert your memory card following the 
instructions in the printed Quick Guide.

Note: After copying a photo to a memory card from a Macintosh computer, an 
older digital camera not be able to read the memory card.

1. Do one of the following:

Windows XP: Click Start and select My Computer.

Windows 98, Me, or 2000: Double-click the My Computer icon on your 
desktop.

Macintosh OS X: Go to step 2.

2. Double-click the removable disk icon, then select the folder in which you want to 
save your photo files.

3. Select the folder on your computer’s hard drive that contains the photo files you 
want to copy. Then select the photo files and drag them to the folder on your 
memory card.
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4. When you’re finished, follow the steps in Disconnecting or Turning Off the 
Epson Stylus CX4700 Series before disconnecting or turning off the CX4700 
Series.

Disconnecting or Turning Off the Epson Stylus 
CX4700 Series

When you finish copying files to or from a memory card, follow the steps in this 
section to properly handle the memory card before disconnecting or turning off the 
CX4700 Series.

Windows XP

1. Click the  icon on the task bar.

2. Select Safely remove USB Mass Storage Device.

3. Turn off the CX4700 Series or disconnect the USB cable.

Windows 2000

1. Make sure that the memory card access light and the On light are not flashing.

2. Turn off your computer.

3. Turn off the CX4700 Series or disconnect the USB cable.

Note: If you turn off the CX4700 Series or disconnect the USB cable before 
turning off your computer, you see the message “Problem Ejecting USB Mass 
Storage Device.”

Windows Me and 98

1. Double-click the My Computer icon on the desktop. 

2. Right-click the Removable Disk icon and click Eject.

3. Turn off the CX4700 Series or disconnect the USB cable.
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Macintosh

1. Drag the removable disk icon ( ) from your desktop into the trash.

2. Turn off the CX4700 Series or disconnect the USB cable.
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Cleaning the Print Head

If your printouts are unexpectedly light or faint, or you notice light or dark bands 
across your printout, you may need to clean the print head. This unclogs the nozzles 
so they can deliver ink properly. Print head cleaning uses ink, so clean it only if 
quality declines.

You can clean the print head using the  ink button on the Stylus CX all-in-one or 
using the Head Cleaning utility on your computer. You can also run a nozzle check to 
see if the print head needs cleaning. (To use the buttons on your Stylus CX to 
perform these functions, see the Quick Guide.)

Note: If the red ink light comes on or flashes, you cannot clean the print head. 
In this case, replace the appropriate ink cartridge first.

Caution: If you don’t use your Stylus CX often, it is a good idea to print a few 
pages at least once a month to maintain good print quality.

■ Checking the Print Head Nozzles

■ Running the Head Cleaning Utility

■ Examining the Nozzle Check Pattern

Checking the Print Head Nozzles

1. Make sure the Stylus CX is turned on but not printing, and the red ink light is 
off. (If the ink light is flashing or on, you need to replace a cartridge.

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Nozzle Check.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select your Stylus CX in the printer list, click OK, and select Nozzle 
Check.
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You see a screen like the following: 

3. Click Print. The nozzle check pattern prints:

4. If there are no gaps or lines, click Finish.

If there are gaps or lines, or the test patterns are faint, click Clean. Then follow 
the steps in Running the Head Cleaning Utility to clean the nozzles.

Running the Head Cleaning Utility

1. Make sure the Stylus CX is turned on but not printing, and the red ink light is 
off. (If the ink light is flashing or on, you need to replace a cartridge. See 
Replacing an Ink Cartridge.

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

Print head does 
not need to be 
cleaned yet:

Print head needs 
to be cleaned:
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Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select your Stylus CX in the printer list, click OK, and select Head 
Cleaning.

You see a screen like the following: 

3. Click Start or Next.

Cleaning takes several seconds. The Stylus CX runs a head cleaning cycle and the 
On light flashes.

Caution: Never turn off the Stylus CX while head cleaning is in progress. You 
may damage it.

4. When the  On light stops flashing, make sure paper is loaded in the Stylus CX, 
then do the following:

Windows: Click Print Nozzle Check Pattern. Then click Print. 

Macintosh: Click Confirmation, then click Next.

The nozzle check pattern prints (see Examining the Nozzle Check Pattern for 
details).

5. If there are no gaps or lines, click Finish.

If there are still gaps or lines, or the test patterns are faint, click Clean to clean the 
print head again. 
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If you don’t see any improvement after cleaning four or five times, refer to 
Problems and Solutions. You can also turn the printer off and wait overnight. 
This lets any dried ink soften. Then try cleaning the print head again.

Tip: If you do not use your Stylus CX often, it is a good idea to print a few pages 
at least once a month to maintain good print quality.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered line should be solid, 
with no gaps, as shown.

■ If there are no gaps or lines, click Finish. 

■ If you see any gaps (as shown below), or the test patterns are faint, click Clean to 
clean the print head again. 

Replacing an Ink Cartridge

■ When the red ink light flashes, one or more ink cartridges are low on ink.

■ When the red ink light stays on, you need to replace the cartridge(s).

You’ll also see a message on your screen when you print telling you which cartridge is 
low or empty. (You cannot print when a cartridge is empty.)

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the red ink light is off.

■ Checking the Ink Supply

■ Purchasing Ink Cartridges
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■ Ink Cartridge Precautions

■ Removing and Installing Ink Cartridges

Checking the Ink Supply

To check your ink supply, do the following:

■ Windows: Double-click the icon on your taskbar (in the lower right corner of 
your screen). You see a window like the following:

■ Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select your Stylus CX in the printer list, click OK, and select EPSON 
StatusMonitor.
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You see a window like this:

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package.

We recommend that you use genuine Epson cartridges. The use of other products 
may affect your print quality and could result in printer damage. Yields vary 
considerably based on images printed, print settings, paper type, frequency of use, and 
temperature. The printer ships with full cartridges and part of the ink from the first 
cartridges is used for priming the printer.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office as described in 
Where To Get Help.

Color Part number

Black T063120

Cyan T063220

Magenta T063320

Yellow T063420

Click a cartridge image to 
display information about it.
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Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children and don’t drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining 
around the ink supply port. If ink gets on your skin, wash it off with soap and 
water. If it gets in your eyes, flush them immediately with water.

Caution: Do not put your hand inside the Stylus CX all-in-one or touch any 
cartridges during printing. 

Install a new ink cartridge immediately after removing an empty one. Leaving 
cartridges uninstalled can dehydrate the print head and may prevent the Stylus 
CX from printing.

If you remove an ink cartridge for later use, protect the ink supply area from dirt 
and dust and store it in the same environment as the Stylus CX. Note that there is 
a valve in the ink supply port, making covers or plugs unnecessary, but care is 
needed to prevent the ink from staining items that the cartridge touches. Do not 
touch the ink cartridge ink supply port or surrounding area. 

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

Caution: Leave the empty cartridge installed until you have obtained a 
replacement, or the ink remaining in the print head nozzles may dry out. To 
ensure good results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your Stylus CX not covered by Epson’s 
warranty.

1. Make sure the Stylus CX is on.
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2. Make sure that the document cover is closed, then open the scanner.

Caution: Do not open the scanner when the document cover is open.

3. Press and release the ink button. The On and ink lights flash. 

If one of the cartridges is low or empty, the Stylus CX moves that cartridge to the 
ink out mark. Go to step 4.

If no cartridges are low or empty, the ink cartridge holder moves to the ink 
replacement position. Go to step 5.

Note: Do not hold down the ink button for more than 3 seconds or the printer 
will start to clean the print head.

Caution: Do not move the print head by hand; this may damage the Stylus CX. 
Always press the ink button to move it.

4. Press the ink button again. 

■ If more than one cartridge is empty or low, the next cartridge moves to the 
ink out mark. 
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■ Once the Stylus CX has identified all of the empty or low ink cartridges, the 
print head moves to the ink cartridge replacement position.

5. Open the cartridge cover.

6. Squeeze the tab at the back of the cartridge and lift it straight out. Dispose of it 
carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your hands, wash them thoroughly with soap and water. 
If ink gets into your eyes, flush them immediately with water. 
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7. Before you open the new ink cartridge package, shake it four or five times. Then 
remove it from the package.

Caution: Do not touch the green chip on the front of the cartridge. This can 
damage the ink cartridge.

8. Place the new ink cartridge into the cartridge holder and push it down until it 
clicks into place.

9. Replace any other cartridges that need to be replaced. 
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10. Close the ink cartridge cover and press it until it clicks into place. 

11. Close the scanner. 

12. Press the ink button. The Stylus CX begins charging ink and the On light 
starts flashing. This takes about one minute. When it’s finished, the On light 
stops flashing and remains on, and the ink light goes out.

Caution: Never turn off the Stylus CX while the On light is flashing or you’ll 
waste ink.
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Note: If the ink light stays on (not flashing), the ink cartridge may not be 
installed correctly. Press the ink button again and reinstall the ink cartridge 
until it clicks into place.

Aligning the Print Head

If your printouts look grainy or blurry, or you see light or dark horizontal banding, 
you may need to align the print head.

Note: Banding may also occur if your cartridges are low on ink or you need to 
clean the print head.

1. Turn on the Stylus CX all-in-one.

2. Load several sheets of paper.

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Print Head Alignment.

Macintosh OS X: Open the Applications folder and select EPSON Print 
Utility. Select your Stylus CX in the printer list, click OK, and select Print Head 
Alignment.

4. Follow the instructions on the screen to print a vertical alignment sheet. You see a 
window like this one:
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5. Look at the four sets of patterns in your printout. For each set, if you see a pattern 
with no visible vertical lines, enter its number in the corresponding box on the 
screen and click Next.

If you can’t find an aligned pattern, choose the one that’s closest to being aligned. 
Click Realignment and then Print to print another alignment sheet and repeat 
this step.

6. Click Print to print a black horizontal alignment sheet. After it’s printed, you see 
a window like this one:

7. Look at the printout and select the pattern with no gap or line between the 
rectangles. Enter the number for that pattern in the box on the screen and click 
Next.

If you can’t find an aligned pattern, choose the one that looks the best. Then click 
Realignment to print another alignment sheet and repeat this step.
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8. Click Print to print a color horizontal alignment sheet. After it’s printed, you see a 
window like this one:

9. Look at the printout and find the pattern with no gap or line between the 
rectangles and enter its number in the box on the screen.

If you can’t find an aligned pattern, choose the one that looks the best. Then click 
Realignment to print another alignment sheet and repeat this step.

10. Click Finish to close the Print Head Alignment Utility.

Cleaning the Stylus CX

To keep your Stylus CX all-in-one working at its best, you should clean it several 
times a year.

1. Turn off the Stylus CX, unplug the power cord, and disconnect the USB cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the glass surface of the document table is dirty, clean it with a soft dry cloth, or 
use a small amount of glass cleaner on a soft cloth to clean it. Do not spray glass 
cleaner directly on the glass.
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4. If the outer case or inside of the sheet feeder is dirty, clean it with a soft cloth 
dampened with mild detergent. Keep the scanner section closed to prevent water 
from getting inside.

5. If ink accidentally gets inside the printer, wipe it off with a damp cloth.

Warning: Don’t touch the gears or any other parts inside the Stylus CX.

Caution: Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner 
for cleaning; they can damage the Stylus CX components and case.

Don’t get water on the Stylus CX components and don’t spray lubricants or oils 
inside the Stylus CX.

Transporting the Stylus CX

If you need to ship your Stylus CX all-in-one, you must prepare it for transportation 
by packing it in its original box or one of a similar size.

Caution: To avoid damage, remove the ink cartridges as described below when 
transporting the Stylus CX.

1. Turn off the Stylus CX. 

2. Remove any paper from the sheet feeder and close the paper support. 

3. Unplug the power cord from the electrical outlet. Then disconnect the USB cable 
from the Stylus CX.

4. Open the scanner section and make sure the ink cartridge holder is in the home 
position on the right.

Clean here
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5. Secure the ink cartridge holder (print head) to the case with tape.

Caution: Be sure to remove the tape after installing the printer in its new 
location.

6. Close the scanner section, push in the output tray extension, and close the output 
tray.

7. Repack the Stylus CX in the original box using the protective materials that came 
with it.

Keep the Stylus CX level as you transport it. 

After transporting the Stylus CX, remove the tape securing the print head, plug in the 
Stylus CX, and turn it on. If you notice a decline in print quality, clean the print head 
as described in Cleaning the Print Head; if output is misaligned, align the print head 
as described in Aligning the Print Head.
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Stylus CX All-in-One Parts

Diagnosing Problems

■ Checking the Lights

Paper support 
extension

Feeder guard

Left edge 
guide

USB port

Paper support

Memory 
card cover 
(Epson Stylus CX4700 
Series only)

USB external 
device 
connector

Document 
cover

Document 
table

Memory card slots 
(Epson Stylus CX4700 
Series only)

Output tray and 
extension

AC inlet

Control panel 
(buttons and lights)

Paper thickness lever

Ink cartridges

Scanner
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■ Running a Printer Check

Checking the Lights

If the lights on the Stylus CX all-in-one come on or flash, or a number or letter 
appears in the Copy window, check the explanations listed below.

Light: status

Copy 

window 

status Cause Solution

On: Flashing

Error: On

— No paper is loaded 
in the sheet 
feeder.

Load paper in the sheet 
feeder. See Loading Paper for 
instructions.

— Multiple pages 
have been fed into 
the sheet feeder.

Remove and reload the paper. 
See Loading Paper for 
instructions.

Error: Flashing — Paper is jammed. See Paper Feeding Problems 
to remove it.

Ink: Flashing — An ink cartridge is 
running low on 
ink.

See Replacing an Ink Cartridge 
for instructions.

Ink: On — An ink cartridge is 
empty or not 
installed correctly.

Error: Flashing

Memory Card (all 
3 lights):
Flashing

(Epson Stylus 
CX4700 Series 
only)

1 A memory card is 
inserted that is not 
supported by the 
Epson Stylus 
CX4700 Series.

Remove the incompatible 
memory card. See the Quick 
Guide for instructions.

The inserted 
memory card does 
not contain any 
valid images.

See the Quick Guide for a list 
of compatible card and image 
types.
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Error: Flashing

Print From Index 
Sheet: Flashing

(Epson Stylus 
CX4700 Series 
only)

2 An index sheet 
was not 
recognized 
because it is not 
positioned 
correctly.

Position the index sheet 
correctly on the glass, aligning 
the top of it with the left edge 
of the glass. Then press 

Start Color to continue or 
Stop to cancel.

3 The index sheet is 
marked 
incorrectly. 
(No marks are 
detected or the 
sheet includes 
more than one 
mark for an 
image.)

Remove the index sheet, mark 
it correctly, and try again. See 
the Quick Guide for 
instructions.

4 The index sheet 
does not match 
the photos on the 
memory card. 

Remove the memory card and 
insert the card used to print 
the index sheet (see the Quick 
Guide for instructions)—or 
place the correct index sheet 
on the glass. Then press 

Start Color to continue or 
Stop to cancel.

Error: Flashing 
fast

H The paper 
thickness lever is 
set to the H 
position.

If you have set the lever to the 
H position because you are 

printing envelopes, continue 
printing. Otherwise, set the 
lever to the L position.

Light: status

Copy 

window 

status Cause Solution
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Note: When you turn off the Stylus CX, a red light inside it may stay on for up to 
15 minutes. This is normal.

Running a Printer Check

You can run a printer check to determine whether a problem comes from the Stylus 
CX itself or some other source.

1. Make sure both the Stylus CX and computer are turned off. Then disconnect the 
USB cable from the Stylus CX.

2. Make sure letter-size plain paper is loaded in the Stylus CX.

3. Press the ink and On buttons together and hold them down for about 
5 seconds. The Stylus CX turns on and prints a test pattern. It also shows the 
percentage of ink left in each cartridge:

4. Turn off the Stylus CX after it prints the test page. Then reconnect the USB cable 
and turn on the Stylus CX and computer.

Error: On

Ink: On

All other lights: 
Flashing

E An Stylus CX part 
needs to be 
replaced.

Contact your local authorized 
servicer or contact Epson for a 
referral; see Where To Get 
Help.

All lights: Flashing E There is a problem 
with the Stylus 
CX.

Turn the Stylus CX off and 
then back on. If the error does 
not clear, contact your local 
authorized servicer or contact 
Epson for a referral; see 
Where To Get Help.

Light: status

Copy 

window 

status Cause Solution
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■ If the test page prints, the problem probably lies in your software settings, the 
USB cable, or your computer. It’s also possible that your software may not be 
installed correctly. See your Start Here sheet for instructions on reinstalling 
the Stylus CX software.

■ If the test page doesn’t print, you may have a problem with the Stylus CX. 
Try the suggestions in Problems and Solutions. If nothing works, contact 
Epson as described in Where To Get Help.

Problems and Solutions

■ Setup and Software Installation Problems

■ Printing or Copying Problems

■ Print Quality Problems

■ Scan Quality Problems

■ Paper Feeding Problems

■ Miscellaneous Printout Problems

Setup and Software Installation Problems

Tip: It’s a good idea to check Epson’s support web site periodically for free 
updates to your printer driver. Visit http://www.latin.epson.com.

The Stylus CX all-in-one makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the Stylus CX must charge its print head 
for a minute or so. Wait until charging finishes (the green On light stops 
flashing) before you turn off the Stylus CX, or it may charge improperly and use 
excess ink the next time you turn it on. 

If the printer stops moving or making noise, but the green On light is still 
flashing after 5 minutes, turn off the Stylus CX. If the light is still flashing when 
you turn it back on, contact Epson as described in Where To Get Help.
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■ Turn off the Stylus CX, then make sure the ink cartridges are inserted completely 
and the ink cartridge cover is closed completely. Also make sure no packing 
material remains in the Stylus CX. Wait a moment, then turn the Stylus CX back 
on to clear the error.

You’re having problems installing the Stylus CX software.

■ Make sure your Stylus CX is turned on and the USB cable is securely connected at 
both ends. Then carefully follow the installation instructions on the Start Here 
sheet. Also make sure your system meets the requirements listed in System 
Requirements.

■ Close your other programs, including any screen savers and virus protection 
software, and install the software again.

■ In Windows, make sure the Stylus CX is selected as the default printer and that 
the correct port is shown in the printer properties.

■ If you’re using Windows 2000 and you see an error message or your software 
doesn’t install correctly, you may not have software installation privileges. Contact 
your System Administrator.

■ If you’re using Windows and the USB port, make sure your system was not 
upgraded from Windows 95. The USB Printer Device Driver may not install 
correctly.

■ Make sure the USB Controller is working properly in Device Manager. See your 
Windows help system for details. If it’s not working, contact your computer 
manufacturer.

■ If you’re printing over a network, see Setting Up Network Printing for 
instructions.

Printing or Copying Problems

Only the green On light is on, but nothing prints.

■ Make sure the USB cable is connected securely at both ends and meets the 
requirements listed in System Requirements.

■ Run a printer check. If the test page prints, make sure your software is installed 
correctly. 
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The Stylus CX sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. For instructions, see Cleaning 
the Print Head.

■ The Stylus CX won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the base in all directions.

The Stylus CX makes noise when you turn it on or after it has been sitting for 
awhile.

The Stylus CX is performing routine maintenance.

You don’t see the printer icon in the lower right corner of your screen 
(taskbar) in Windows.

Try restarting your computer. If you still don’t see the icon, follow these steps:

1. Click Start, point to Settings or Printers and Faxes, then select Printers. 

2. Right-click your Stylus CX and select Printing Preferences. 

3. Click the Maintenance tab.

4. Click the Speed and Progress button, then click the Monitoring Preferences 
button.

5. Click the Shortcut Icon box. Then click OK to close the open windows.

Printing is too slow.

Make sure your system meets the requirements listed in System Requirements. If 
you’re printing a high-resolution image, you need more than the minimum 
requirements listed. You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close programs that you’re not using.

■ Increase your system’s memory.

For the fastest printing, try these tips:

■ Choose black ink in your printer settings if your document doesn’t include color.

■ For Windows, choose Draft for Quality Type.
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■ For Macintosh, set the Quality/Speed slider to Speed.

■ If the Stylus CX is connected to a USB hub, disconnect unused USB devices.

Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning. See Cleaning the Print Head

■ Select a higher Quality Option or Print Quality and turn off High Speed mode. 
See Printing in Windows or Printing with Macintosh OS X.

■ Make sure the paper Type or Media Type setting matches the paper you loaded; 
see Selecting the Correct Paper Type for guidelines.

■ Make sure the printable side of the paper is face up. It’s usually brighter or whiter.

■ The ink cartridges may need replacing. See Replacing an Ink Cartridge

■ If you have a Macintosh, try using Automatic mode. See Printing with Macintosh 
OS X for instructions.

■ Run the Print Head Alignment utility.

■ If a dotted line appears in the image, clean the scanner glass with a soft, dry, 
lint-free cloth (paper towels are not recommended), or use a small amount of glass 
cleaner on a soft cloth, if necessary. Don’t spray glass cleaner directly on the 
glass. See Cleaning the Stylus CX for details.
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Your printout is blurry or smeared.

■ Make sure your paper isn’t damp or curled, or loaded face down (the printable 
side should be face up).

■ Use a support sheet with special paper, or try loading your paper one sheet at a 
time.

■ Make sure your paper meets the specifications listed in Paper.

■ Use Epson papers to ensure proper saturation and absorption of genuine Epson 
inks.

■ Set the paper thickness lever to the L position for most paper types. If you are 
printing on envelopes, set the lever to the H position. See Loading Paper for 
details.

■ Align the print head. See Aligning the Print Head

■ If you are copying, make sure your original is placed flat against the document 
table glass and the Stylus CX is not tilted or placed on an uneven surface.

■ Remove each sheet from the output tray as it is printed.

■ Avoid handling printouts on glossy paper for a few hours to allow the ink to set.

■ If ink smears on the back of a printout, clean the inside of the printer. See 
Cleaning the Stylus CX

■ If you are using double-sided paper and printing heavily saturated or dark images 
on the front side of the paper, you may notice that smudges or marks appear on 
the front when you print the second side. If one side of the paper will contain a 
lighter image or text, print that side first to eliminate marks or smudging.
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Your printout is faint or has gaps.

■ The print head nozzles may need cleaning. See Cleaning the Print Head

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details. 

■ Make sure the paper Type or Media Type setting matches the paper you loaded. 
See Selecting the Correct Paper Type for guidelines.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, 
reload a new stack of paper with the printable side up; it is usually brighter or 
whiter than the other side. For best results, use genuine Epson paper.

You see wrong or missing colors.

■ Make sure your printer software is not set to use black ink only.

■ The print head nozzles may need cleaning. See Cleaning the Print Head

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details.

■ Try turning off PhotoEnhance.™ 

■ For Macintosh, try using Automatic mode.

■ Try changing the Gamma setting; see Customizing Windows Print Settings, 
Customizing Mac OS X Print Settings.

■ Your printed colors can never exactly match your on-screen colors. However, you 
can use a color management system to get as close as possible. Try using the ICM 
(Windows) or ColorSync (Macintosh) setting. 

■ For best results, use genuine Epson ink and paper.
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Your printout is grainy.

■ Make sure the printable side of the paper is face up. It’s usually brighter or whiter.

■ Try using a higher quality paper or select a higher Quality Option or Print 
Quality setting. See Printing in Windows or Printing with Macintosh OS X.

■ Select Photo RPM for Quality Type (Windows) or Print Quality (Macintosh). 
Remember that this setting increases print time.

■ Run the Print Head Alignment utility.

■ You may need to increase the image resolution or print it in a smaller size; see 
your software documentation.

Scan Quality Problems

You see only a few dots in your scanned image.

■ Make sure the document is placed on the document table with the side to be 
scanned facing down. See Placing Originals for Scanning for details.

■ When scanning with the Black&White setting in Home or Professional Mode, 
change the Threshold setting. See Adjusting the Color and Other Image Settings 
for instructions.

A line of dots always appears in your scanned images.

If a dotted line appears in the image, clean the scanner glass with a soft, dry, lint-free 
cloth (paper towels are not recommended), or use a small amount of glass cleaner on a 
soft cloth, if necessary. Don’t spray glass cleaner directly on the glass. See Cleaning 
the Stylus CX for details.

Straight lines in your image come out crooked.

Make sure the document lies perfectly straight on the document table.

Your image is distorted or blurred.

■ Make sure the document lies flat on the document table. Also make sure your 
document is not wrinkled or warped.

■ Make sure you do not move the document or the Stylus CX while scanning.
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■ Make sure the Stylus CX is placed on a flat, stable surface.

■ Select Unsharp Mask Filter in EPSON Scan’s Professional Mode window. See 
Adjusting the Color and Other Image Settings for instructions.

■ Adjust the Auto Exposure setting in EPSON Scan’s Professional Mode window. 
See Adjusting the Color and Other Image Settings for instructions.

You can also select Color Control and Continuous auto exposure in the 
Configuration window, or select the Color tab and click the Recommended 
Value button to return the Auto Exposure setting to the default. See EPSON 
Scan Help for details.

■ Increase the Resolution setting. See Selecting the Scan Resolution for instructions.

Colors are patchy or distorted at the edges of your image.

If your document is very thick or warped at the edges, cover the edges with paper to 
block external light as you scan.

Your scanned image is too dark

■ Change the Display Gamma setting to match your output device, such as a 
monitor or printer, in the EPSON Scan Configuration window. See EPSON 
Scan Help for details.

■ Adjust the Auto Exposure setting in EPSON Scan’s Professional Mode window. 
See Adjusting the Color and Other Image Settings for instructions.

You can also select Color Control and Continuous auto exposure in the 
Configuration window, or select the Color tab and click the Recommended 
Value button to return the Auto Exposure setting to the default. See EPSON 
Scan Help for details.

■ Check the Brightness setting in EPSON Scan’s Home or Professional Mode (see 
Adjusting the Color and Other Image Settings). Or adjust brightness using the 
Histogram in Professional Mode (see EPSON Scan Help).

■ Check the brightness and contrast settings of your computer monitor.
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An image on the back of your original appears in your scanned image.

If your original is printed on thin paper, images on the back may be visible to the 
Stylus CX and appear in your scanned image. Try scanning the original with a piece 
of black paper placed on the back of it. Also make sure the Document Type and 
Image Type settings are correct for your original. See Selecting Basic Settings for 
details.

Moiré (cross-hatch) patterns appear in your scanned image.

A moiré is a cross-hatch pattern that may appear in a scanned image of a printed 
document. It is caused by interference from the differing pitches in the scanner’s 
screen and the halftone screen in your original.

■ Select the Descreening Filter check box in EPSON Scan’s Home or Professional 
Mode window. In Professional Mode, set the Screen Ruling of the Descreening 
Filter setting to an appropriate setting for your document and deselect the 
Unsharp Mask Filter setting. See Adjusting the Color and Other Image Settings 
for instructions.

■ Select a lower Resolution setting. See Selecting the Scan Resolution for 
instructions.

Characters are not recognized well when converted into editable text (OCR).

■ Make sure the document lies perfectly straight on the document table. 

■ In Home Mode, select Black&White as the Image Type setting. In Professional 
Mode, select None for the B&W Option setting. Then try adjusting the 
Threshold setting.

■ Check your OCR software manual to see if there are any settings you can adjust in 
your OCR software.

Scanned colors differ from the original colors.

■ Change the Image Type setting in EPSON Scan’s Home or Professional Mode. 
See Selecting Basic Settings for instructions. Select different combinations of this 
setting and the others mentioned below.

■ Change the Display Gamma setting to match your output device, such as a 
monitor or printer, in the EPSON Scan Configuration window. See EPSON 
Scan Help for details.
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■ Adjust the Auto Exposure setting in EPSON Scan’s Professional Mode. Also try 
selecting a different Tone Correction setting. See Adjusting the Color and Other 
Image Settings for instructions. 

■ Try selecting the following settings in the Configuration window: Color Control, 
Continuous auto exposure, and Recommended Value (on the Color tab). 
Also try turning off the Fast Preview setting. See EPSON Scan Help for details.

■ Check the color matching and color management capabilities of your computer, 
display adapter, and software. Some computers can change the palette of colors on 
your screen. See your software and hardware manuals for details.

■ Use the color management system for your computer: ICM for Windows or 
ColorSync for Macintosh. With Windows, add a color profile that matches your 
monitor to improve on-screen color matching. (Exact color matching is very 
difficult. Check your software and monitor documentation for information on 
color matching and calibration.)

■ Printed colors can never exactly match the colors on your monitor because 
printers and monitors use different color systems: monitors use RGB (red, green, 
and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

You have trouble adjusting the scan area in the thumbnail preview.

■ Create a marquee or adjust the existing marquee to select the area you want to 
scan. See Adjusting the Scan Area (Marquee) for instructions.

■ In the Configuration window, adjust the thumbnail cropping area using the 
Thumbnail Cropping Area slide. See EPSON Scan Help for details.

■ Switch to the Normal preview type (if available) and preview your image again. 
See Previewing and Adjusting the Scan Area for instructions.

Paper Feeding Problems

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
Start Color button to eject the paper, and then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin. See the Paper 
specifications.
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Paper doesn’t feed correctly or jams in the printer.

■ If paper doesn’t feed, remove it from the sheet feeder. Reload it against the right 
edge, behind the tabs, then slide the left edge guide against the paper. Make sure 
the paper is not in front of the feeder guard.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, then reload it.

■ Don’t load too many sheets at once (up to 20 sheets of photo paper or 100 sheets 
of plain paper). See Special Papers for details.

■ Heavily saturated prints may curl, causing a paper jam when printing on both 
sides of the paper.

■ If paper is jammed, the red Error light flashes. Follow these steps to clear the jam:

1. Press the Start Color button to eject the jammed paper. If the jammed paper 
is not ejected, go to the next step.

2. If the paper is stuck near the sheet feeder or output tray, gently pull it out.

If the paper is stuck inside the Stylus CX, press the On button to turn it off. 
Open the scanner and remove any paper inside, including any torn pieces. Do not 
pull it backward however; this can damage the sheet feeder. Close the scanner, 
then turn the Stylus CX back on.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up.

■ Fan the edges of the stack of paper to separate the sheets.

■ Don’t load paper above the arrow mark inside the left edge guide.

■ Place the paper against the right edge behind the tab. Slide the left edge guide 
against it, but not too tightly.

■ If you’re printing on both sides of the paper, try loading fewer sheets.

Miscellaneous Printout Problems

The image is inverted, as if viewed in a mirror.

■ Turn off the mirror setting in your application program. 
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■ For Windows, turn off Mirror Image in the Page Layout window of your printer 
driver.

■ For Macintosh, turn off Flip Horizontal in the Print Settings window.

The Stylus CX prints blank pages.

■ If you’re using Windows, make sure the Stylus CX is selected. For Macintosh OS 
X, make sure your printer is selected in the Page Setup and Print windows.

■ The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions. 

The margins are incorrect.

■ Make sure the paper settings are correct for your paper size. For instructions, see 
Printing in Windows or Printing with Macintosh OS X.

■ Make sure the paper you loaded matches the paper size and paper type settings 
you selected on the Stylus CX control panel or in your printer software.

■ Choose the correct margins for your paper size.

■ If you’re using Mac OS X, make sure you choose the same printer in the Page 
Setup window and the Print window.

■ Use the Print Preview option in your printer software to check your margins 
before you print.

■ Make sure your paper is positioned next to the right side of the feeder.

Output is not what you expect when printing borderless photos.

■ Make sure you are printing on papers that support borderless printing. See 
Loading Paper for Borderless Photos for details.

■ Use the expansion setting to adjust how the image fits on the page. See Printing 
Borderless Photos.

■ Don’t choose a custom paper size setting when printing borderless photos.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for 
multiple copies.
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You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the requirements listed 
in System Requirements. Then try printing again.

■ Make sure your printer is selected in Windows, or is set as the active printer in 
Print Center (Mac OS X). 

■ If you’re using a switch box or USB hub with your printer, connect the printer 
directly to your computer.

The image size/position is incorrect.

Make sure the paper and layout options are set correctly.

There are scratches on your print.

If you’re printing on glossy paper, prints may be scratched if not handled properly. 
Don’t place objects on top of your prints, and be careful not to scratch them with 
your fingernails. For best results, frame your prints under glass.

Uninstalling Your Software

■ Windows

■ Macintosh OS X

Windows

1. Turn off the Stylus CX.

2. Disconnect the USB cable from the Stylus CX.

3. Click Start, and select Programs or All Programs.

4. Point to Epson or Epson Printers, then select Epson Printer Software 
Uninstall.

5. In the next window, select EPSON Stylus CX4100 Series or EPSON Stylus 
CX4700 Series, and click OK. Then follow the on-screen instructions.
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6. Open the Windows Control Panel and double-click the Add or Remove 
Programs icon (Windows XP) or the Add/Remove Programs icon (Windows 
Me, 98, or 2000).

7. Click EPSON Scan in the list of currently installed programs and click 
Change/Remove (Windows XP or 2000) or Add/Remove (Windows Me or 
98).

8. When the confirmation window appears, click Yes.

9. Follow the on-screen instructions to uninstall EPSON Scan.

In some cases, a message may appear to prompt you to restart the computer. If so, 
make sure Yes, I want to restart my computer now is selected and click 
Finish.

10. Restart your computer, then see the Start Here sheet to reinstall your software.

Macintosh OS X

1. Open the Applications folder, then the Utilities folder.

2. Open the Printer Setup Utility or Print Center, hold down the  key and select 
your Stylus CX, then click the Delete button.

3. Insert the Stylus CX software CD-ROM in your CD-ROM or DVD drive.

4. Double-click the Epson CD-ROM icon on your desktop.

5. Open the Drivers > English > ESCAN folder.

6. Double-click the EPSON Scan Installer icon.

7. When the Installer window appears, select Uninstall from the pop-up menu at 
the top and click the Uninstall button.

8. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

Setting Up Network Printing

■ Windows XP and 2000

■ Windows Me and 98SE
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■ Macintosh OS X

Windows XP and 2000

This section tells you how to set up the Stylus CX all-in-one so that other computers 
on the network can print to it.

Note: This section is for small network users only. If you are on a large network 
and would like to share the Stylus CX, consult your network administrator.

To install software programs in Windows 2000, it is necessary to log on as a user 
with administrative privileges (a user who belongs to the Administrators group).

To install software programs in Windows XP, it is necessary to log on with a 
Computer Administrator account. You cannot install software programs if you log 
on as a Limited account user. After you install Windows XP, the user account is 
set as a Computer Administrator account.

The images that are provided in the following section pertain to Windows XP.

First, you need to set up the Stylus CX as a shared printer on the computer that it is 
directly connected to. Then, you must install the Stylus CX on each computer that 
will access it through the network.

Setting Up a Shared Printer

Follow the steps below to configure your computer to share the Stylus CX with other 
computers on a network.

1. Click Start > Control Panel or Start > Settings > Control Panel, then click 
Printers and Other Hardware or Printers and Faxes.

2. Windows XP: You may need to click View installed printers or fax printers.

3. Right-click the icon for the Stylus CX, then click Sharing.

4. Select Shared as or Share this printer, then type a name for the shared printer.

Note: Do not use spaces or hyphens in the shared printer name.
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Note: With Windows XP, you may need to run the Network Setup Wizard before 
you can set up printer sharing. Start the wizard and follow the on-screen 
instructions until you see the screen above.

5. If you want Windows XP or 2000 to automatically download printer drivers to 
computers that are running different versions of Windows, click Additional 
Drivers and select the environment and the operating systems for the other 
computers. Click OK, then insert the printer software CD into the CD-ROM 
drive. Select the folder for Windows XP or 2000. Click OK to install the 
additional drivers.

6. Click OK, or click Close if you installed additional drivers.

Accessing a Network Printer

Follow the steps below to print to the Stylus CX from other computers on a network.
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Note: The Stylus CX must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another computer. 
For instructions, see Setting Up a Shared Printer.

1. Click Start > Control Panel or Start > Settings > Control Panel, then click 
Printers and Other Hardware or Printers and Faxes.

2. Select Add a printer or double-click the Add Printer icon. The Add Printer 
Wizard opens.

3. Click Next. 

4. Select A network printer, or printer attached to another computer and click 
Next.

5. On the next screen, click Next.
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6. Double-click the icon of the computer that is directly connected to the Stylus CX. 
Then, click the icon for the Stylus CX.

7. Click Next and follow the on-screen instructions.

Note: Depending on the operating system and the configuration of the computer 
to which the Stylus CX is connected, the Add Printer Wizard may prompt you to 
install the printer driver from the Stylus CX software CD. In this case, click the 
Have Disk button and follow the on-screen instructions.

Windows Me and 98SE

This section tells you how to set up the Stylus CX all-in-one so that other computers 
on the network can print to it.

Note: This section is for small network users only. If you are on a large network 
and would like to share the Stylus CX, consult your network administrator.

First, you need to set up the Stylus CX as a shared printer on the computer that it is 
directly connected to. Then, you must install the Stylus CX on each computer that 
will access it through the network.
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Setting Up a Shared Printer

Follow the steps below to configure your computer for printer sharing and to share 
the Stylus CX with other computers on a network.

1. Click Start > Settings > Control Panel.

2. Double-click the Network icon.

3. Click the File and Print Sharing button.

4. Select the I want to be able to allow others to print to my printer(s) check 
box and click OK.

5. In the Network dialog box, click OK.

Note: If a dialog box requesting the insertion of the Windows Me or 98 CD-ROM 
appears, insert the CD into the CD-ROM drive and follow the on-screen 
instructions.

If a dialog box requesting that you restart your computer appears, do so. Then 
continue with step 6.

6. In the Control Panel, double-click the Printers icon.

7. Right-click the icon for the Stylus CX, then click Share As.
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8. Type a name for the shared printer, then click OK.

Accessing a Networked Printer

Follow the steps below to print to the Stylus CX from other computers on a network.

Note: The Stylus CX must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another computer. 
For instructions, see Setting Up a Shared Printer.

1. Click Start > Settings > Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard opens.

3. Click Next.
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4. Select Network printer, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that the Stylus CX is directly connected to. 
Then, click the icon for the Stylus CX.

7. Click OK and follow the on-screen instructions.

Macintosh OS X 

To share the Stylus CX all-in-one with other computers on a network, follow the 
steps below to configure the computer that it is directly connected to.
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Setting Up a Shared Printer

To share the Stylus CX with other Mac OS X computers on a network, follow the 
steps below to configure the computer that it is directly connected to.

1. Turn on the Stylus CX.

2. Select System Preferences from the Apple® menu or the dock, then select the 
Sharing icon.

3. Click the checkbox next to Printer Sharing and close System Preferences. 

Accessing a Networked Printer

Follow the steps in this section to access the Stylus CX from other Macintosh OS X 
computers on the network.

1. Turn on the Stylus CX.

2. Print as you normally would, choosing the Stylus CX from the Shared Printers list 
that appears in the Page Setup and Print menus.
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Where To Get Help

Epson provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table.

Internet support service in Latin America 

Telephone support service in Latin America

Note: If your country does not appear on the list, contact the nearest Epson sales 
office.

Toll or long distance charges may apply. Before you call, please have the following 
information ready:

■ Product name (Epson Stylus CX4100 Series or Epson Stylus CX4700 Series)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

Service Access

World Wide 
Web

From the Internet, you can reach Epson Support at 
www.latin.epson.com. At this site, you can download drivers and 
other files, access troubleshooting information, and receive technical 
advice through e-mail.

Country Telephone number

Argentina (54-11) 4346-0300

Brazil (55-11) 4196-6350

Chile (56-2) 230-9500

Colombia (57-1) 523-5000

Costa Rica (506) 210-9555
(1-800) 377-6627

Mexico
Mexico City
Other cities

(52-55) 1323-2052
01-800-087-1080

Peru (51-1) 224-2336

Venezuela (58-212) 240-1111
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■ Computer configuration and operating system version

■ Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office.
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System Requirements

■ Windows System Requirements

■ Macintosh System Requirements

Windows System Requirements

To use your Stylus CX all-in-one and its software, your system should have: 

■ A Microsoft® Windows compatible PC with a Pentium®-equivalent processor 
(300 MHz or faster recommended)

■ Microsoft Windows 98SE, Windows 2000, Windows Me, or Windows XP

■ At least 256MB RAM (512MB recommended)

■ 200MB free hard disk space (300MB recommended)

■ VGA monitor with at least a 256 color display

■ CD-ROM or DVD drive for installing the printer software

■ A computer with preinstalled Windows 98SE, 2000, Me, or XP, and a 
Windows-compliant USB port and shielded USB “AB” cable. Using an 
improperly shielded USB cable may cause the printer to malfunction. 

Macintosh System Requirements

To use your Stylus CX all-in-one and its software, your system should have: 

■ An Apple® iMac™ series or Power Macintosh® G3, G4, or G5 with built-in USB 
port

■ Macintosh OS X 10.2.x to 10.3.x

■ 512MB RAM

■ 200MB free hard disk space (300MB recommended)

■ VGA monitor with at least a 256 color displa

■ CD-ROM or DVD drive for installing the printer software
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■ A shielded USB “AB” cable. Using an improperly shielded USB cable may cause 
the printer to malfunction.

Specifications

■ Printing

■ Scanning

■ Paper

■ Printable Area

■ Memory Card Slots (Epson Stylus CX4700 Series Only)

■ Ink Cartridges

■ Mechanical

■ Electrical

■ Environmental

■ Standards and Approvals

■ USB Interface
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Printing

Scanning

Paper

Note: Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, Epson cannot guarantee the quality of any 
non-Epson brand or type of paper. Always test a sample of paper stock before 
purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Black: 90 nozzles

Color: 270 nozzles (90 each cartridge: cyan, magenta, 
yellow)

Print direction Bidirectional with logic seeking

Scanner type Flatbed color

Photoelectric device CIS

Effective pixels 10,200 × 14,040 pixels at 1200 dpi

Document size 216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size

Scanning resolution 1200 dpi (main scan)
2400 dpi with Micro Step (sub scan)

Output resolution 50 to 4800, 7200, and 9600 dpi
(50 to 4800 dpi in 1 dpi increments)

Scanning speed Approximately 30 msec per line at 1200 dpi

Image data 16 bits per pixel per color internal
8 bits per pixel per color external (maximum)

Interface One USB 2.0 Hi-speed or USB 1.1 port

Light source RGB Three Color LED
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Single sheets

Envelopes

Note: Poor quality paper may reduce the print quality and cause paper jams or 
other problems. If you have print quality problems, switch to a higher grade 
paper.

Do not load curled or folded paper.

Size A4 (210 × 297 mm [8.3 × 11.7 in.])

A5 (148 × 210 mm [5.8 × 8.3 in.])

A6 (104 × 149 mm [4.1 × 5.8 in.])

Letter (8.5 × 11 in. [216 × 279 mm])

Legal (8.5 × 14 in. [216 × 356 mm])

Half-letter (5.5 × 8.5 in. [140 × 216 mm])

4 × 6 in. (102 × 152 mm)

5 × 7 in. (127 × 178 mm)

3.5 × 5 in. (89 × 127 mm)

8 × 10 in. (203 × 254 mm)

User Defined up to 216 mm × 1.12 m (8.5 × 44 in.)

Paper type Plain bond paper or special paper distributed by Epson

Thickness 0.08 to 0.13 mm (0.003 to 0.005 in.)

Weight (for plain bond 
paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)

Size No. 10 (4.1 × 9.5 in.; 105 × 241 mm)

DL (4.3 × 8.7 in.; 109 × 221 mm)

C6 (4.5 × 6.4 in.; 114 × 163 mm)

132 × 220 mm

Paper type Plain bond paper

Thickness 0.40 to 0.52 mm (0.016 to 0.02 in.)

Weight 64 g/m² (20 lb) to 90 g/m² (24 lb)
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Use paper only under these conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Printable Area

Single sheets or cards

Envelopes

A: The minimum top margin is 0.12” (3.0 mm).

B-L: The minimum left margin is 0.12” (3.0 mm).

B-R: The minimum right margin is 0.12” (3.0 mm).

C: The minimum bottom margin is 0.12” (3.0 mm).

D The minimum bottom margin is 0.78” (20 mm) for envelopes.

A

C

B-L B-R

Normal Borderless*
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Note: Always load paper into the sheet feeder with the short edge first. Load 
envelopes flap edge left with the flap side down.

Memory Card Slots (Epson Stylus CX4700 Series 
Only)

* Adapter required

* When printing with the borderless feature, print quality may decline in the 
expanded area. Before printing large jobs using the borderless setting, print a 
single sheet to confirm printout quality.

Compatible memory cards CompactFlash 

SmartMedia (maximum capacity 128MB)

Memory Stick

Memory Stick PRO

Memory Stick Duo*

Memory Stick PRO Duo*

MagicGate Memory Stick

MagicGate Memory Stick Duo*

Microdrive

SD (Secure Digital) Card

MultiMediaCard

miniSD card*

xD-Picture Card

Voltage Requirements 3.3 v

Maximum current is 500 mA
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Memory Card Slot Compatibility

Ink Cartridges

* Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution: To ensure good results, use genuine Epson ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
Epson’s warranty.

Do not use an ink cartridge if the date on the package has expired.

CF Type II card slot Compatible with CF+ and CompactFlash Specification 
1.4 cards

SmartMedia card slot Compatible with SmartMedia Standard 2000 cards

Memory 
Stick/MemoryStick PRO 
card slot

Compatible with Memory Stick Standard version 1.3 or 
Memory Stick Standard Memory Stick PRO Format 
Specifications version 1.0 cards

SD/MMC card slot Compatible with SD Memory Card Specifications / 
PART1. Physical Layer Specification Version 1.0 cards 
and MultiMediaCard Standard cards

xD-Picture card Slot Compatible with xD-Picture card Card Specification 
Version 1.00 cards

Color Cyan, magenta, yellow, black

Cartridge life 6 months at 77 °F (25 °C) after opening the package

Temperature Storage: 

–4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)

Freezing*: 3.2 °F (–16 °C)
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Mechanical

Electrical

Environmental

Paper path Sheet feeder, top entry

Sheet feeder capacity About 100 sheets at 64 g/m² (17 lb)

Dimensions Width: 430 mm (16.9 in.)

Depth: 354 mm (13.9 in.)

Height: 181 mm (7.1 in.)

(without the rubber feet or the paper support extended)

Weight 6.8 kg (15 lb) without the ink cartridges

Input voltage 90 to 132 V

Rated frequency 50 to 60 Hz

Rated current 0.4 A (0.7 A max)

Power consumption Approx. 13 W (operating)

Approx. 4 W in sleep mode

Approx. 4.5 W in low power mode

Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)

Humidity
(without condensation)

Operation: 20 to 80% RH

Storage*: 5 to 85% RH
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Standards and Approvals

USB Interface

Important Safety Instructions

Before using your Stylus CX all-in-one, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the Stylus CX.

■ Use only the type of power source indicated on the Stylus CX label.

■ Use only the power cord that comes with the Stylus CX. Use of another cord may 
cause fires or shock. Do not use the cord with any other equipment.

■ Place the Stylus CX near a wall outlet where the plug can be easily unplugged.

■ Do not let the power cord become damaged or frayed.

Safety UL 60950

CSA C22.2 No. 60950

EMC FCC part 15 Subpart B class B

CAN/CSA-CEI/IEC CISPR 22

Standard Based on Universal Serial Bus Specifications Revision 
2.0, Universal Serial Bus Device Class Definition for 
Printing Devices Version 1.1, Universal Serial Bus Mass 
Storage class Bulk-Only Transport Revision 1.0

Bit rate 480 Mbps (High speed device)

Data encoding NRZI

Adaptable connector USB Series B

Recommended cable 
length

Under 2 meters
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■ If you use an extension cord with the Stylus CX, make sure the total ampere 
rating of the devices plugged into the extension cord does not exceed the cord’s 
ampere rating. Also, make sure the total ampere rating of all devices plugged into 
the wall outlet does not exceed the wall outlet’s ampere rating.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the Stylus CX for sufficient ventilation. Do not block 
or cover openings in the Stylus CX case or insert objects through the slots.

■ Do not place the Stylus CX near a radiator or heating vent or in direct sunlight.

■ Place the Stylus CX on a flat, stable surface that extends beyond its base in all 
directions. It will not operate properly if it is tilted or at an angle. 

■ Make sure the back of the Stylus CX is at least 10 cm (3.9 in.) away from the wall.

■ Do not open the scanner section while the Stylus CX is copying, printing, or 
scanning.

■ Do not spill liquid on the Stylus CX.

■ Except as specifically explained in your documentation, do not attempt to service 
the Stylus CX yourself.

■ Unplug the Stylus CX and refer servicing to qualified service personnel under the 
following conditions: if the power cord or plug is damaged; if liquid has entered 
the product; if the product has been dropped or the case damaged; if the product 
does not operate normally or exhibits a distinct change in performance. Adjust 
only those controls that are covered by the operating instructions.

■ When storing or transporting the Stylus CX, do not tilt it, stand it on its side, or 
turn it upside down; otherwise ink may leak from the cartridge.

■ The lamp in this product contains mercury. Dispose of according to local, state, 
or federal laws.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and don’t drink the ink.
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■ Be careful when you handle used ink cartridges; there may be ink remaining 
around the ink supply port. If ink gets on your skin, wash it off with soap and 
water. If it gets in your eyes, flush them immediately with water.

■ Do not put your hand inside the Stylus CX or touch any cartridges during 
printing.

■ Install a new ink cartridge immediately after removing an empty one. Leaving 
cartridges uninstalled can dehydrate the print head and may prevent the Stylus 
CX from printing. 

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt 
and dust and store it in the same environment as the Stylus CX. Note that there is 
a valve in the ink supply port, making covers or plugs unnecessary, but care is 
needed to prevent the ink from staining items that the cartridge touches. Do not 
touch the ink cartridge ink supply port or surrounding area.
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Appendix

■ Copyright Notice

■ A Note Concerning Responsible Use of Copyrighted Materials

■ Trademarks

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without the prior written permission of Seiko 
Epson Corporation. The information contained herein is designed only for use with 
this Epson printer. Epson is not responsible for any use of this information as applied 
to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of 
this product or third parties for damages, losses, costs, or expenses incurred by 
purchaser or third parties as a result of: accident, misuse, or abuse of this product or 
unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and 
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from 
the use of any options or any consumable products other than those designated as 
Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

A Note Concerning Responsible Use of Copyrighted 
Materials

Ink jet printers, like photocopiers, conventional cameras, digital cameras, and 
scanners, can be misused by improper copying and reprinting of copyrighted material. 
While some countries’ laws permit limited copying of copyrighted material in certain 
circumstances, those circumstances may not be as broad as some people assume. 
Epson encourages each user to be responsible and respectful of the copyright laws 
when using ink jet printers, scanners, and digital cameras.
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Trademarks

Epson and Epson Stylus are registered trademark of Seiko Epson Corporation.

DURABrite, BorderFree, and RPM are registered trademarks; Print Lab, 
PhotoEnhance, and Easy Photo Fix are trademarks; and Epson PhotoCenter and is a 
service mark of Epson America, Inc.

DPOF™ is a trademark of CANON INC., Eastman Kodak Company, Fuji Photo 
Film Co., Ltd. and Matsushita Electric Industrial Co., Ltd.

SD™ is a trademark.

Memory Stick, Memory Stick Duo, Memory Stick PRO, and Memory Stick PRO 
Duo are trademarks of Sony Corporation.

xD-Picture Card™ is a trademark of Fuji Photo Film Co., Ltd.

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners. Epson disclaims any and all rights 
in those marks.

© 2005 by Epson America, Inc. 
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